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TUJUAN PEMBELAJARAN 

 
 

Modul Pelajaran Tujuan Pembelajaran 

Modul 1 Setelah mempelajari modul 1 ini, anda diharapkan dapat menjalankan program
Microsoft  Excel 2007, dan  mengenali interface/tampilan  dan  menu‐menu yang 
ada serta dapat membuat, menyimpan dan menutup dokumen kerja anda. 

Modul 2 Pada   modul  ke  2  ini  anda  diharapkan  dapat  mengenal   dan   memehami
Workbook   dan   Worksheet   dan   menggunakan   perintah   dasar   dalam   Excel, 
seperti  cara  mengaktifkan sel, membuat range, autofill dan beberapa perintah 
yang lainnya. 

Modul 3 Setelah mempelajari modul ke 3 ini, anda diharapkan dapat mengatur workbook
dan  worksheet,  yaitu  cara  memformat  worksheet,  menyisipkan  sel,  baris  dan 
kolom, serta beberapa fitur yang lainnya. 

Modul 4 Kemampuan anda pada modul ke 4 ini sudah dituntut dapat menggunakan fitur
pengaturan  tampilan    lembar  kerja,  yaitu  dengan  mengatur  jenis  huruf/font, 
perataan paragraf, format angka dan beberapa fitur yang lainnya. 

Modul 5 Setelah  mempelajari modul ke 5 ini, anda diharapkan  dapat  mengenal dan
menggunakan operasi dasar dan menengah terhadap fungsi bantu aritmatika di 
dalam Microsoft Excel. 

Modul 6 Setelah    mempelajari   modul   6   ini,   anda   diharapkan    dapat    memahami
penggunaan absolut sel, dan penggunaan fungsi dasar aritmatika lebih lanjut. 

Modul 7 Diharapkan anda dapat memahami dan  menggunakan  operator  dan  fungsi
bantu logika if serderhana di dalam Microsoft Excel 2007. 

Modul 8 Setelah  mempelajari modul 8 ini, anda diharapkan dapat  menyisipkan  media
objek gambar clipart, autoshapes, wordart di ke dalam worksheet anda. 

Modul 9 Diharapkan setelah mempelajari modul ke 9 ini, anda mampu  membuat grafik
dan mengatur formatnya sehingga grafik mudah dibaca dan lebih menarik. 

Modul 10 Anda  diharapkan dapat memahami dan menggunakan  pengurutan  data dan
jenis‐jenis pengurutannya di dalam Excel 2007. 

Modul 11 Setelah  mempelajari modul 11 ini, anda diharapkan dapat  memahami dan
menggunakan cara pengaturan halaman di dalam Microsoft Excel 2007. 

Modul 12 Modul terakhir ini khusus membahas masalah pencetakan lembar kerja kita, jadi
anda diharapkan dapat memahami dan mampu mencetak sebagian atau seluruh 
lembar kerja yang ada. 
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Modul 1. Mengenal Microsoft Excel 2007 
 

Materi Langkah Detailnya 
 

Menjalankan Microsoft 
Excel 2007. 

1.    Cara  1  :  Klik  tombol  Start  >  All  Program  >  Microsoft  Office  >  Microsoft 
Office Excel 2007. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Cara 2 : Klik tombol Start > Run > ketikkan “excel” > Enter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Pengenalan 
Interface/Tampilan 
Microsoft Excel 2007. 

Pada  Windows  Microsoft  Excel  2007  yang  muncul, terdapat  beberapa 
tampilan  sebagai  berikut  (tunjukkan  dengan    mouse  anda  masing–masing 
komponen berikut) : 
 
Office  Button  ‐  Quick  Access  Toolbar  ‐  Menu  Bar  (Baris  Menu)  ‐  Title  Bar 
(Baris  Judul)  ‐  Tool  Bar  (Baris  Tool  Bar)  ‐  Tombol  Ukuran  (Sizing  Button)  ‐ 
Name   Box   ‐   Formula  Bar   –   Column  –   Baris   ‐   Tab  Worksheet  ‐   Insert 
Worksheet  ‐  Status  Bar  ‐   Document  Area  ‐  Horizontal  Scroll  Bar  ‐  Vertical 
Scroll Bar ‐ Zoom ‐ Tampilan Layar. 
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1.   Office Button  terdiri  atas perintah  New  Document, Open,  Convert,  Save, 
Save as, Print, Prepare, Send, Publish dan Close. 

2.   Quick Access Toolbar, terdiri dari tombol yang dapat mempercepat kerja 
anda. Isinya hampir sama dengan perintah‐perintah di Office Button. Jika 
anda ingin melihatnya langsung bisa menekan tanda panah. 

3.   Menu  Bar,  terdiri  dari  perintah  menu  utama  Microsoft  Excel  2007  yaitu 
Home, Insert, Page Layout, Formulas, Data, Review, View. 

4.   Title Bar, berisi nama file dan program aplikasi yang sedang aktif. 
5.   Tool  Bar,  tombol‐tombol  bergambar  yang  memiliki  fungsi  tertentu  dan 

digunakan untuk menjalankan suatu perintah dengan cepat dan mudah. 
6.   Tombol Ukuran, digunakan untuk mengatur ukuran jendela kerja. 
7.   Name Box, Nama sel yang sedang aktif akan ditampilkan pada Name Box. 
8.   Formula Bar, anda  bisa mengedit data pada sebuah sel. 
9.   Sel Aktif, tempat menuliskan atau mengedit data dan dikelilingi oleh garis 

batas yang lebih tebal. 
10. Column,  Setiap  kolom  memiliki  nama  berdasarkan  Abjad,  dari  kolom  A 

hingga Z, dilanjut AA hingga XFD. 
11. Baris, untuk setiap baris memiliki nama berdasarkan Angka. Dari 1 hingga 

1048576. 
12. Tab Worksheet, perintah dimana anda bisa berpindah ke kertas kerja lain 

dengan mudah. 
13. Insert Worksheet, dengan menekan Insert Worksheet anda bisa membuat 

Worksheet baru yang letaknya berurutan dengan Worksheet sebelumnya. 
14. Status Bar, Status lembar kerja anda. 
15. Document Area, merupakan lembar kerja yang aktif. 
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16. Horizontal  Scroll  Bar,  perintah  untuk  menggeser  layar  ke  kiri  atau  ke 
kanan. 

17. Vertical Scroll Bar, perintah untuk menggeser layar ke atas atau ke bawah. 
18. Tampilan Layar, terdiri dari perintah untuk merubah tampilan layar. Terdiri 

dari  Tampilan  Normal,  Tampilan  Page  Layout  dan  Tampilan  Page  Break 
Preview. 

19. Zoom, perintah untuk memperbesar & memperkecil tampilan pada lembar 
kerja anda. 
 

 
Materi Langkah Detailnya 

 
Mengaktifkan Menu‐ 
Menu Pada Microsoft 
Excel2007. 

1.    Untuk  mengaktifkan  Menu  Home,  coba  anda  klik  tab  Menu  Home   pada 
tab menu atau tekan Alt+H, perhatikan ribbon menu yang tampil. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.  Untuk  mengaktifkan  Menu  Insert,   coba  anda  klik  Menu  Insert   pada  tab 

menu atau tekan Alt+N, perhatikan ribbon menu yang tampil. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.  Untuk  mengaktifkan  Menu  Page  Layout,   coba  anda  klik   tab  Menu  Page 

Layout    pada  tab  menu  atau  tekan  Alt+P,  perhatikan  ribbon  menu  yang 
tampil. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.  Untuk  mengaktifkan  Menu  Formulas,   coba  anda  klik  tab  Menu  Formulas 
pada tab menu atau tekan Alt+M, perhatikan ribbon menu yang tampil. 
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5. Untuk mengaktifkan Menu Data,   coba anda klik tab Menu  Data pada tab 
menu atau tekan Alt+A, perhatikan ribbon menu yang tampil . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.   Untuk mengaktifkan Menu Review,   coba anda klik tab Menu Review pada 
tab menu atau tekan Alt+R, perhatikan ribbon menu yang tampil. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

7. Untuk mengaktifkan Menu View,   coba anda klik tab Menu  View pada tab 
menu atau tekan Alt+W, perhatikan ribbon menu yang tampil. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Untuk mengaktifkan Office Button,  coba anda klik tab Menu  Office Button 
pada tab menu atau tekan Alt+F, perhatikan ribbon menu yang tampil. 
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Tip : Jika mouse anda terdapat tombol scrollnya, maka anda dapat 
berpindah dari satu menu ke menu lainnya dengan menggeser tombol 
scroll yang ada pada mouse anda. 

 

 
Tombol Scroll 

 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Membuat Dokumen 
Baru Dalam Microsoft 
Excel  2007. 

1. Klik Office Button > New. 
 

2. Pada Kotak Dialog yang muncul Pilih > Blank Document > klik tombol Create. 
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3.    Untuk   membuat   dokumen   baru   dari   Templates,   pilih   pada   bagian 
kelompok Templates, Klik Tombol Create. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Pada  windows  yang  muncul,  letakkan  kursor  dimana  anda  akan  mulai 
mengetik. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Sel aktif (A1), diberi kotak 
dengan garis lebih tebal Kolom yang tampak 

(kolom A hingga kolom N) 
 
 

Baris yang tampak (kolom 
1 hingga kolom 7) 
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Materi Petunjuk Pengerjaan Tugas 
 

Contoh Soal Kemudian ketikkanlah teks di bawah ini (ketikan teksnya saja. Untuk 
fomat dokumennya akan dibahas pada latihan berikutnya). 

 
DAFTAR NILAI SISWA 

No Nama Siswa Kelas Nilai Akhir 

1 Titin Mayasari 7A 75

2 Eri Yanto 7B 86

3 Muhammad Taufan 7C 92

 
 
 

Materi Langkah Detailnya 
 

Menyimpan Dokumen 
Kerja 

1.    Setelah teks di atas selesai anda ketik, klik Office Button. 
 
2.    Pilih  Save  atau  Save  As  (untuk  menyimpan  dengan  nama  yang  beda 

dengan nama sebelumnya). 
 

3.    Pilih Excel Document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Pada windows yang muncul, pilih folder Document, ketikkan Latihan1 pada 
File name. Pilih Word Document pada  Save as type. 
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4. Klik tombol Save. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menutup Dokumen 
Kerja. 

1.    Klik Office Button > Close (Ctrl + W). 
 

2.    Kemudian muncul kotak dialog baru klik Yes 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 1 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas
Modul 1” . 

 
 
 

DAFTAR SISWA 
 

NIS NAMA JK TANGGAL LAHIR ALAMAT KOTA 
9930001 Aditya P 5‐Dec‐1963 Jl. Astina 23 Bandung 
9930005 Susana W 15‐Jan‐1965 Jl. Kopo 32 Bandung 
9930007 Anastia W 16‐Dec‐1967 Jl. Soka 22 Jakarta 
9930015 Desiana W 30‐Nov‐1959 Jl. Metri II/5 Jakarta 
9930032 Roy P 5‐Jan‐1958 Jl. Telaga 28 Semaran 
9930041 Iksan P 9‐Oct‐1966 Jl. Kenari 234 Surabaya 
9930058 Titin P 5‐Oct‐1964 Jl. Banten 45 Pontianak 
9930063 Caleb P 23‐Dec‐1968 Jl. Jaya 44 Bandung 
9930075 Riana W 15‐May‐1965 Jl. Marga 66 Garut 
9930080 Diana W 23‐May‐1968 Jl. Kinanti 456 Blitar 
9930092 Hari P 14‐Aug‐1967 Jl. Dadali 132 Bandung 
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Modul 2. Bekerja Dengan Microsoft Excel 
 

Materi Detail 
 

Mengenal Workbook 
dan Worksheet 

1.    Membuat Worksheet baru 
 

• Klik tombol Insert Worksheet pada tab Worksheet. 
 

 
 
 
 
 
 
 
 
 
 

Membuat Worksheet Baru 
 
 
 
 
 
 
 
 

• Anda akan mendapatkan Worksheet baru dibelakang Worksheet yang 
telah ada. 

 
 
 
 
 
 
 
 
 
 
 

Membuat Worksheet Baru 
 

 
 
 
 
 
 
 

2.    Mengubah Nama Worksheet 
 

• Klik kanan pada Worksheet yang mau diganti nama nya. 
 

• Pada menu pop‐up yang muncul klik Rename. 
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Mengubah nama worksheet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Masukkan nama Worksheet yang baru, lalu tekan Enter pada keyboard 
anda. 

 

• Hasil perubahan namanya bisa anda lihat di bawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Perubahan nama Worksheet 
 
 
 
 
 
 

3.    Menghapus Worksheet 
 

• Klik kanan pada Worksheet yang mau dihapus. 
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• Pada menu pop‐up yang muncul klik Delete. 
 
 
 
 
 
 
 
 
 
 

Menghapus Worksheet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Hasilnya dapat anda lihat pada gambar di bawah ini. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Detail 
 

Mengenal & Membuat 
Range 

Berikut ini adalah langkah‐langkah membuat range. 
 

1.    Letakkan kursor pada sel awal range yang anda inginkan. 
 

2.    Klik dan tahan tombol kiri mouse. 
 

3.    Bawa kursor ke sel akhir range. 
 

4.    Lepaskan tombol kiri mouse. 
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Membuat Range 
 
 
 
 
 
 
 
 
 

Materi Detail 
 

Memasukkan Data ke 
Dalam Sel 

Sekarang   anda   akan   belajar   memasukkan   data   ke   dalam   sel.   Langkah‐ 
langkahnya sebagi berikut : 
 

1.    Jadikan sel tersebut sebagai sel aktif. 
 

2.    Ketik data pada sel tersebut. 
 
3.    Tekan tombol Enter. Atau tombol panah pada keyboard untuk 

memindahkannya. 
 

 
 
 
 

Memasukkan data ke 
dalam sel 

 
 
 
 
 
 

Materi Detail 
 

Fasilitas AutoFill 1.    Berikut langkah‐langkah untuk memasukkan data secara berurutan 
 

•   Masukkan dua data pertama pada sel. 

•   Buat range pada kedua kotak data pertama tersebut. 

•   Klik dan tahan kotak kecil yang terletak pada sudut kanan bawah range. 

•   Kotak yang menampilkan isi sel akan muncul. 

•   Lepaskan tombol mouse kiri. 
 

•   Maka,  seluruh  sel  pada  range  tersebut  akan  terisi  secara  otomotis 
dengan data yang berurutan. 
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Data berurutan 
 
 
 
 
 
 
 
 
 
 
 

2.    Memasukkan variasi data yang berupa angka dan teks. 
 

• Masukkan dua data pertama pada sel. 

• Buat range pada kedua kotak data pertama tersebut. 
 

• Klik  dan  tahan  kotak  kecil  yang  terletak  pada  sudut  kanan  bawah 
range. 

• Kotak yang menampilkan isi sel akan muncul. 

• Lepaskan tombol mouse kiri. 
 

• Maka, seluruh sel pada range tersebut akan terisi data angka dan teks 
secara berurutan. 

 
 
 
 
 
 
 

Variasi data dan 
angka 

 

 
 
 
 
 
 
 
 

3.    Memasukkan data hari, bulan serta tanggal. 
 

• Masukkan dua data pertama pada sel. 

• Buat range pada kedua kotak data pertama tersebut. 
 

• Klik  dan  tahan  kotak  kecil  yang  terletak  pada  sudut  kanan  bawah 
range. 

 

• Geser    mouse    untuk    memperbesar    area    range    sesuai    dengan 
keinginanmu. 
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• Kotak yang menampilkan isi sel akan muncul. 

• Lepaskan tombol mouse kiri. 
 

• Maka, seluruh sel pada range  tersebut  akan terisi data tanggal bulan 
dan tahun secara berurutan. 

 
 
 
 
 
 

Data tanggal,bulan 
dan tahun 
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Materi Langkah Detailnya 
 

Pengenalan Kursor Excel Ketikkan di lembar kerja Excel 
 
 
 
 
 
 
 
 

a)    Kursor Seleksi. 
 
 
 
 
 
 
 
 

b)    Kursor Tampilan Blok. 
 
 
 
 
 
 
 
 
 

c)    Kursor Untuk Memindahkan. 
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Materi Langkah Detailnya 
 

Memindahkan Isi Sel 1.    Tempatkan  mouse  di  bagian  tepi  (garis  tebal),  tapi  jangan  pada  bagian 
ujung‐ujungnya, sampai keluar tanda panah bersilangan. Pastikan bentuk 
kursor berubah seperti contoh berikut. 

 
 
 
 
 
 
 
 

2.    Klik kiri mouse pada bagian tepi sel, tetap tekan tombol kiri mouse sambil 
gerakkan ke sel C2. Lepaskan tombol kiri mouse di sel C2. Hasilnya seperti 
ini: 

 

 
 
 
 
 
 

C2 
3.    Maka Nama Siswa pindah ke kanan bawah (C2) 

 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Kursor Untuk 
Menggandakan 
(Mencopy) 

Ketikkan di lembar kerja Excel 
 
 
 
 
 
 
 
 
Langkah‐langkah untuk menggandakan (Mengkopi). 
 

• Kursor untuk menggandakan. 
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• Menggandakan isi sel. 
 

 
 

• Setelah di Draf maka Nama Siswa akan tercopi sebanyak yang kita 
inginkan. Contohnya seperti yang di bawah ini. 

 

 
 
 
 

Materi Langkah Detailnya 
 

Mengatur Lebar Kolom 1.    Siapkan data seperti contoh di bawah ini. 
 

 
 

2.    Geser   kursor   pada   bagian   tepi   kanan   header   kolom   A,   B,   C   secara 
bergantian atau klik 2x pada bagian tepi kanan header pada kolom A, B, C 
secara bergantian. Maka hasilnya seperti  di bawah ini. 

 

 
 

Langkah‐langkah mengatur lebar kolom. 
 

• Klik dua kali pada kolom A. Maka besar kolom akan berubah secara 
otomatis. Maka hasilnya seperti di bawah ini. 
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• Klik  dua kali  pada  Kolom  B.   Maka  besar  kolom  akan  berubah  secara 
otomatis. Maka hasilnya seperti di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 

• Klik  dua kali  pada  Kolom  B.   Maka  besar  kolom  akan  berubah  secara 
otomatis. Maka hasilnya seperti di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Mengatur tinggi baris 1.    Tempatkan mouse di bagian bawah (garis) baris 1. Perhatikan contoh di 
bawah ini. 

 
 
 
 
 
 
 
 
 
 
 

2.    Klik kiri mouse, tetap tekan sambil gerakkan mouse ke arah bawah untuk 
memperlebar baris. Hasilnya lihat gambar di bawah ini. 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 2 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas
Modul2” . 

Ketikkanlah data di bawah ini pada lembar keja Excel dan tolong rapikan lebar kolom dan tinggi 
kolomnya agar terlihat lebih rapi. 

 
 
 
 
 

DAFTAR SISWA 
    

NIS NAMA JK TANGGAL
LAHIR 

ALAMAT KOTA 

9930001 Aditya P 5‐Dec‐1963 Jl. Astina 23 Bandung
9930005 Susana W 15‐Jan‐1965 Jl. Kopo 32 Bandung
9930007 Anastia W 16‐Dec‐1967 Jl. Soka 22 Jakarta
9930015 Desiana W 30‐Nov‐1959 Jl. Metri II/5 Jakarta
9930032 Roy P 5‐Jan‐1958 Jl. Telaga 28 Semaran
9930041 Iksan P 9‐Oct‐1966 Jl. Kenari 234 Surabaya
9930058 Titin P 5‐Oct‐1964 Jl. Banten 45 Pontianak
9930063 Caleb P 23‐Dec‐1968 Jl. Jaya 44 Bandung
9930075 Riana W 15‐May‐1965 Jl. Marga 66 Garut
9930080 Diana W 23‐May‐1968 Jl. Kinanti 456 Blitar
9930092 Hari P 14‐Aug‐1967 Jl. Dadali 132 Bandung
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Modul 3 Mengatur Workbook & Worksheet 
 

Materi Langkah Detailnya 
 

Memindahkan Isi 
Worksheet 

Berikut ini langkah‐langkah untuk memindahkan isi Worksheet dari satu lokasi ke 
lokasi yang lain. 
 

1.    Buatlah range pada data Worksheet yang akan dipindahkan. 
 

2.    Klik  menu  Home,  kemudian  klik  toolbar  Cut yang  terletak  dalam  toolbar 
Clipboard. 

 
 
 

Menggunakan Fungsi 
Cut 

 

 
 
 
 
 
 
 
 
 
 

3.    Garis batas range akan berkedip‐kedip jika rangenya sudah di Cut. 
 

4.    Buatlah sel aktif pada tempat yang dituju. 
 

5.    Klik menu Home, kemudian klik toolbar Paste yang terletak dalam toolbar 
Clipboard. 

 
 
 
 
 
 
 
 
 
 

Hasil Fungsi Paste 
 

 
 
 
 
 
 
 
 

6.    Hasilnya seperti gambar yang anda lihat diatas. 
Materi Langkah Detailnya 

 
Menggandakan Isi 
Worksheet 

Langkah‐langkah untuk menggandakan Worksheet dapat anda ikuti di bawah ini. 
 

1.    Buatlah range pada data Worksheet yang akan dipindahkan. 

2.    Klik  menu  Home,  kemudian  klik  toolbar  Copy yang  teletak  dalam  toolbar 
Clipboard. 
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Menggunakan Fungsi Copy 
 

3.    Buatlah sel aktif  pada tempat yang dituju. 

4.    Klik menu Home, kemudian klik toolbar Paste  yang teletak dalam toolbar 
Clipboard. 

 
 
 
 
 
 
 
 
 
 
 

Menggunakan Fungsi 
Paste 

 
 
 
 
 
 

5.    Hasilnya seperti gambar yang anda lihat di atas. 
Materi Langkah Detailnya 

 
Menyisipkan Sel 
Baru 

Berikut langkah‐langkah menyisipkan sel baru pada Worksheet. 
 

1.    Blok sel yang akan disisipkan sel baru. 

2.    Klik menu Home, kemudian klik toolbar Insert  yang terletak dalam 
toolbox Cells. Maka akan muncul kotak dialog Insert. 

3.    Pada kotak dialog Insert terdapat empat pilihan untuk menentukan pergeseran 
sel‐sel lama. Pilih salah satu yang akan anda gunakan. 
• Shift cells right untuk menggeser sel‐sel lama ke kanan. 
• Shift sells down untuk menggeser sel‐sel lama ke bawah. 
• Shift sells row untuk menyisipkan garis‐garis baru. 
• Shift sells column untuk menyisipkan kolom‐kolom baru. 
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4.    Tekan tombol OK. 
Materi Langkah Detailnya 

 
Menyisipkan Kolom 
Baru 

Untuk menyisipkan kolom baru pada pada worksheet, langkah‐langkahnya sebagai 
berikut. 
 

1.    Blok kolom yang akan yang akan disisipkan kolom baru. 

2.    Klik menu Home, kemudian klik tanda panah  pada toolbar Insert  
yang terletak dalam toolbox Cells. 

3.    Klik Insert Sheet Column pada menu pop‐up yang muncul. 
 
 
 
 
 
 
 
 
 
 
4.    Klik  Insert  Sheet  Columns ,  maka  hasilnya  dapat 

anda lihat seperti gambar di bawah ini. 
 
 
 
 
 
 
 
 
 

Hasil menyisipkan 
kolom 
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Materi Petunjuk Pengerjaan Tugas 
 

Menyisipkan Baris 
Baru 

Untuk menyisipkan kolom baru pada pada worksheet, langkah‐langkahnya sebagai 
berikut. 
 

1.    Buatlah satu atau beberapa range baris, dimana baris baru akan disisipkan. 
 

2.    Klik menu Home, kemudian klik tanda panah pada toolbar Insert 
yang terletak dalam toolbox Cells. 

 
 
3.    Klik Insert Sheet Rows , maka hasilnya dapat anda 

lihat seperti gambar di bawah ini. 
 
 
 
 
 
 
 
 
 
4.    Maka, baris baru akan bertambah seperti pada gambar di bawah ini. 

 
 
 
 
 
 
 
 
 

Hasil Menyisipkan 
Baris 

 

 
 
 
 

Materi Langkah Detailnya 
 

Mengubah Isi Sel Mengubah isi sel bisa dilakukan dengan dua cara, yaitu dengan menimpa isi sel 
yang lama dengan isi sel yang baru atau dengan cara mengedit isi sel lama. 

 
1.    Langkah‐langkah  untuk  menimpa  isi  sel  yang  lama  dengan  isi  sel  yang  baru 

adalah sebagai berikut. 
• Jadikan sel yang akan diubah sebagai sel aktif. 
• Ketik isi sel yang baru pada sel yang aktif tersebut. 
• Tekan  Enter  atau  tamda  panah  pada  keyboard  anda  untuk  memindahkan 

sel aktif. 
2.    Langkah‐langkah mengubah isi sel dengan cara mengedit. 

• Klik ganda pada sel yang isinya akan diedit. 
• Pada sel tersebut akan muncul kursor. 
• Edit isi sel tersebut. 
• Lalu tekan Enter. 
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Materi Langkah Detailnya 
 

Menghapus Isi 
workbook 

Berikut cara menghapus isi dalam Workbook. 
 

1.    Menghapus  isi  sel.  Jadikan  isi  sel  yang  akan  dihapus  sebagai  sel  aktif  >  tekan 
Delete pada keyboard anda. 

2.    Menghapus  isi  range.  Buatlah  range  yang  isinya  akan  dihapus  >  tekan  Delete 
pada keyboard anda. 

3.    Menghapus Worksheet. Klik kanan lembar sheet, maka akan muncul manu pop‐ 
up > klik Delete pada menu pop‐up tersebut. 

4.    Menghapus Workbook. Buka Windows Explorer > Blok File yang akan dihapus > 
tekan Delete pada keyboard anda. 

Materi Langkah Detailnya 
 

Mengubah Isi Sel Langkah‐langkah menyembunyikan kolom sebagai berikut. 
 

1.    Buatlah range pada kolom yang akan disembunyikan. 
 

2.    Klik  menu  Home,  lalu  klik  toolbar  Format yang  terletak  dalam 
toolbox Cells hingga muncul menu pop‐up. 

3.    Pilih Hide & Unhide , kemudian klik Hide Kolomns 

. 
 

 
 
 
 
 
 
 
 
 
 

Menyembunyikan Kolom 
 
 
 
 
 

4.    Maka, hasilnya dapat anda lihat pada gambar di bawah ini. Untuk kolom yang 
disembunyikan, penyembunyian kolom tersebut ditandai dengan garis tebal. 

 

 
 
 
 
 
 
 
 
 
 

Tampilan Menyembunyikan 
Kolom 

 

 
 
 
 

Materi Langkah Detailnya 
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1. Klik menu Home, lalu klik toolbar Format yang terletak dalam
 toolbar Cells. Akan muncul menu pop‐up.  

2. Pilih  Hide & Unhide ,  kemudian  klik Unhide

Menampilkan 
Kembali Kolom Yang 
Tersembunyi 

Langkah‐langkahnya sebagai berikut. 

 

 
 
 
 

Kolomns . 
 
 
 
 
 
 
 
 
 
 

Menampilkan Kolom Kembali 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menyembunyikan 
Baris 

Caranya sama saja seperti menyembunyikan kolom. Biar lebih jelas anda bisa lihat 
langkah‐langkahnya di bawah ini. 
 

Langkah‐langkah menyembunyikan kolom sebagai berikut. 
 

1.    Buatlah range pada baris yang akan disembunyikan. 

2.    Klik  menu  Home,  lalu  klik  toolbar  Format    yang  terletak  dalam 
toolbox Cells hingga muncul menu pop‐up. 

3.    Pilih  Hide  &  Unhide ,  kemudian  klik  Hide  Rows 

. 
 

 
 
 
 
 
 
 
 
 
 

Menyembunyikan Baris 
 

 
 
 
 
 
 

4.    Maka,  hasilnya  dapat  anda  lihat  pada  gambar  di  bawah  ini.  Untuk  baris  yang 
disembunyikan, penyembunyian kolom tersebut ditandai dengan garis tebal. 
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Tampilan 
Menyembunyikan Baris 

 

 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menampilkan 
Kembali Baris Yang 
Tersembunyi 

Langkah‐langkahnya sebagai berikut. 
 

1.    Klik  menu  Home,  lalu  klik  toolbar  Format    yang  terletak  dalam 
toolbar Cells. Akan muncul menu pop‐up. 

2.    Pilih Hide & Unhide , kemudian klik Unhide Rows 

. 
 
 
 
 
 
 
 
 
 
 

Menampilkan Baris Kembali 
 
 
 
 
 

Materi Petunjuk Pengerjaan Tugas 
 

Menyembunyikan 
Worksheet 

Berikut langkah‐langkah untuk menyembunyikan Worksheet. 
 

1.    Letakkan kursor pada worksheet yang akan disembunyikan. 
2.    Klik kanan mouse hingga muncul menu pop‐up. 
3.    Klik Hide. 
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4.    Hasilnya bisa anda lihat di bawah ini. 
 

 
 
 
 
 
 
 
 

Materi Detail 
 

Menampilkan 
Kembali Worksheet 
Yang Tersembunyi 

Berikut langkah‐langkah untuk mengembalikan Worksheet yang tersembunyi. 
 

1.    Letakkan kursor pada sheet. 
2.    Klik kanan mouse hingga muncul menu pop‐up. 
3.    Klik Unhide. 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.    Pada   kotak   dialog   Unhide   pilih   nama   Worksheet   yang   akan   ditampilkan 

kembali. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.    Hasilnya bisa anda lihat di bawah ini. 
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Materi Langkah Detailnya 
 

Menyisipkan kolom 
baru 

1.    Tempatkan sel  aktif di C1. 

 
 
 
 
 
 
 
 
 
 
 

2.    Klik kanan mouse, maka akan muncul pilihan berikut. 
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3.    Maka akan bertambah kolom C. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menyisipkan baris baru 1.    Tempatkan sel  aktif di A1. 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Klik kanan mouse, maka akan muncul pilihan berikut. 
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3.    Maka akan bertambah baris A. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menambah data Setelah kita menyisipkan kolom dan baris sekarang kita akan menambah data 
pada kolom dan baris yang telah kita buat. 

 

1.    Kolom yang telah disisipkan. 
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2.    Baris yang telah disisipkan. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 3 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas 
Modul 3” . 

Ketikkanlah data di bawah ini pada lembar keja Excel. 
 

No Nama Nilai 
1 Titin Mayasari 86
2 Eri Yanto 75

 
3 

Muhammad
Taufan 93

4 Supra Yogi 85
5 Novi Jayanti 95

 

 
 

Ubahlah data di atas menjadi seperti di bawah ini. 
 

DAFTAR NILAI SISWA 
N 
o 

 
Nama Kelas Nilai 

1 Titin Mayasari 7A 86
2 Eri Yanto 7B 75
3 Muhammad Taufan 7C 93
4 Supra Yogi 7D 85
5 Novi Jayanti 7E 95
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Modul 4. Mengatur Tampilan Lembar Kerja 
 

Materi Langkah Detailnya 
 

Memilih Jenis dan 
Ukuran Huruf 

1.    Ketikkan dokumen di bawah ini dalam lembar kerja anda. 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Kemudian di sel A1, ubah jenis font dengan “Times New Roman”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Klik pada ukuran huruf, lalu ubah menjadi 28. 
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Materi Langkah Detailnya 
 

Mengatur format font 1.    Klik sel yang akan diubah. Tempatkan sel aktif di A1. 
 

 
 
 
 
 
 
 
 
 
 
 
 

2.    Klik pilihan format huruf yang dibutuhkan. 
 

• Bold (Ctrl+B) untuk membuat teks menjadi tebal. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Italic (Ctrl+I) untuk membuat teks menjadi miring. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Underline  (Ctrl+U) untuk membuat teks bergaris bawah. 
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Materi Langkah Detailnya 
 

Mengatur Alignment 1.    Kemudian kita akan melakukan perataan teks di lembar kerja anda, 
tempatkan sel aktif di A1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Blok sel A1 sampai dengan sel C1. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Klik Merger and Center untuk menggabungkan sel A1 sampai dengan 
sel C1  dan membuat teks berada di tengah‐tengah sel  A1 sampai dengan 
C1. 
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4.    Klik pilihan Align yang dibutuhkan. 
 

• Klik Align Center   untuk membuat teks berada ditengah A3. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Klik Align Text left untuk membuat teks berada disebelah kiri. 
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• Klik Align Text Right untuk membuat teks berada disebelah kanan. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menambah Garis Tebal 1.    Kemudian  kita  akan  membuat  garis  di  sekitar  lembar  kerja,  letakkan  sel 
aktif di A2. 
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2.    Blok (klik kiri mouse dan tekan) dari A2 sampai dengan C5. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Klik  tombol  Buttons,  dan  pilih  garis  yang  sesuai.  Untuk  latihan  ini  kita 
memilih All Borders. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Lihat hasilnya di tabel di bawah ini. 
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Materi Langkah Detailnya 
 

Mengatur Shading 1.    Dari data di atas, kita akan menambahkan “shading” warna latar belakang 
dari sel, blok dari sel A2 hingga C2, lalu klik Format > Format Cells 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Lalu pilih “Fill”, pada background color plih warna biru. Kemudian klik Ok. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Kemudian klik font, pilih warna font menjadi putih. 
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5.    Tampilan akhir dari dokumen kerja anda adalah sebagai berikut: 
 

 
 

Materi Langkah Detailnya 
 

Mengatur Tampilan 
Tanggal dan Waktu 

1.    Ketikkan dokumen ini di lembar kerja anda. 
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2.    Blok data dari sel B3 ke B8, kemudian atur format tanggal, dari Home > 
Format > Format Cell 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Dari  menu  Format  Cell  pilih  Date  >  Type  lalu  pilih  format  tanggal  yang 
sesuai. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.   Kemudian klik “Ok” 
5.    Kemudian blok lagi di sel C3 sampai C8, lalu pilih Format Cell > Time, pilih 

jenis Time yang anda inginkan. 
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6.   Kemudian klik “Ok” 
 

Materi Langkah Detailnya 
 

Mengatur format angka 1.    Ketikkan dokumen berikut di lembar kerja anda: 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Kemudian atur format tampilan seperti di bawah ini: 
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3.    Blok dari sel C4 ke C12, Lalu pilih Format > Format Cell > Number. 
Klik  centang,  pada  “use  1000  separator”  untuk  menambah  titik  di  setiap 
tiga angka 0. 

 

 
 

4.    Lalu klik Ok. 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 4 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas
Modul 4” . 
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Modul 5. Bekerja dengan Operasi Bilangan 
 

Materi Langkah Detailnya 
 

Operasi Penjumlahan 1.    Ketik contoh di bawah pada lembar kerja Excel. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Tempatkan sel aktif di C2. Kita akan menjumlahkan Kolom 1 dan Kolom 2. 
 

3.    Pada sel C2, ketik rumus berikut ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Kerjakan bagian berikutnya (sel C3 sampai C6) dengan cara yang sama, 
yaitu menjumlahkan sel A dengan sel B. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Tip : Ada beberapa hal yang perlu diperhatikan pada operasi penjumlahan. 
 

• Jangan lupa menuliskan tanda = diawal proses perhitungan. 
 

• Jangan sampai salah memasukkan sel yang akan dijumlahkan. 
 

• Jangan    lupa    tanda    +    untuk    menambahkan    sel‐sel    yang    akan 
dijumlahkan. 
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Materi Langkah Detailnya 
 

Operasi Pengurangan 1.    Ketik contoh di bawah pada lembar kerja Excel. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Pengurangan dilakukan dengan mengurangi Kolom 2 dengan Kolom 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Kerjakan  bagian  berikutnya  (sel  C3  sampai  C6)  dengan  cara  yang  sama, 
yaitu mengurangi  sel B dengan sel A. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Operasi Perkalian 1.    Ketik contoh di bawah pada lembar kerja Excel. 
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2.    Perkalian dilakukan dengan mengalikan Kolom 1 dengan Kolom 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Kerjakan  bagian  berikutnya  (sel  C3  sampai  C6)  dengan  cara  yang  sama, 
yaitu mengalikan  sel A dengan sel B. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Operasi Pembagian 1.    Ketik contoh di bawah pada lembar kerja Excel. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Pembagian dilakukan dengan membagikan Kolom 2 dengan Kolom 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Kerjakan  bagian  berikutnya  (sel  C3  sampai  C6)  dengan  cara  yang  sama, 
yaitu membagikan  sel B dengan sel A. 
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Materi Langkah Detailnya 
 

Penggabungan Operasi 
Aritmatika 

1.    Ketik contoh di bawah pada lembar kerja Excel. 

 

 
 
 
 
 
 
 
 
 
 
 

2.    Tahap  1  adalah  penjumlahan  dari  Kolom  1  dan  Kolom  2.  Berarti  sel  D2 
akan berisi =A2+B2. Pastikan kolom D telah terisi semua. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Setelah mendapatkan hasil pada Tahap 1, kita akan mengerjakan Tahap 2. 
Sel ini adalah hasil pembagian Tahap 1 dengan  Kolom 3. Berarti E2 akan 
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berisi = D2/C2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Operasi Aritmatika 
Lanjut 

1.    Ketik contoh di bawah pada lembar kerja Excel. 
 

 
 
 
 
 
 
 
 
2.    Tempatkan sel aktif di bagian Rata‐rata, yaitu di sel F2. 
 
3.    Rata‐rata   dihitung   dengan   cara   menjumlahkan   ketiga   nilai,   kemudian 

dibagi 3. Jika ditulis formulakan seperti di bawah ini. 
 

Rata‐rata =(Nilai 1 + Nilai 2 + Nilai 3)/3 
 

4.    Sel  F2 akan berisi =(C2+D2+D3)/3. 
 
 
 
 
 
 
 
 
 

Perhatikan   penulisan   formulanya.   Jangan   lupa   menuliskan   kurung 
pembuka dan penutupnya. 

 

5.    Dan hasilnya, lihat gambar di bawah ini. 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 5 Sekarang coba kerjakan soal berikut ini 
 

Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas 
Modul 5” . 

 
 
 

1.    Hasil penjumlahan diperoleh dari penjumlahan Kolom 1 + Kolom 2 + Kolom 3. 
 

 
 

2.    Hasil pengurangan diperoleh dari pengurangan  Kolom 1 ‐  Kolom 3. 
 

 
 

3.    Hasil perkalian diperoleh dari perkalian  Kolom 1 * Kolom 2. 
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4.    Hasil pembagian  diperoleh dari pembagian Kolom 3 / Kolom 1. 
 

 
 

5.    Carilah nilai untuk jumlah nilai dan rata‐rata. 
 

• Jumlah nilai didapat dari hasil penjumlahan Nilai B. Indonesia, B.Inggris dan Matematika. 
 

• Rata‐rata didapatkan dengan membagi Jumlah Nilai dengan 3. 
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Modul 6. Menggunakan Fungsi Dasar 
 

Materi Langkah Detailnya 
 

Alamat Relatif, Absolut 
dan Semiabsolut 

a.    Alamat Relatif 
 

1.    Ketikkan pada lembar kerja anda: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Pada D3: ketikkan rumus =B3*C3, sel B3 dan C3 disebut sebagai alamat 

relatif. Sekarang gandakan D3 ke sel D4, 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.    Secara otomatis, sel D4 berisikan rumus =B4*C4,  demikian juga jika anda 

gandakan di sel D5 dan D6, maka rumus akan juga berubah. 
 

B. Alamat Absolut 
 

1.    Ketikkan pada lembar kerja anda: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Pada sel C4 ketikkan rumus  =B4*$B$2, ketikkan tanda “$” di depan nama 

kolom dan baris. Kemudian anda gandakan di sel C5. 
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3.    Secara  otomatis,  sel  C5  berisikan  rumus  =B5*$B$2,    alamat  $B$2  tidak 
berubah karena bersifat absolut. 

 

C. Alamat Semiabsolut 
 

Alamat semiabsolut terdiri dari 2 yaitu: 
 

a.    Semiabsolut  yang  tanda  $  didepan  nama  kolom,  jika  digandakan  nama 
kolom tetap, sedang nama baris berubah 

 
b.    Semiabsolut  dengan  tanda  $  didepan  nama  baris,  jika  digandakan  maka 

kolom berubah, nama baris tetap. 
 

 
 
 

Materi Langkah Detailnya 
 

Memahami penggunaan 
fungsi dasar 

a.    Fungsi SUM() 
 

1.    Ketikkan di lembar kerja anda seperti di bawah ini: 
 

 
 
2.    Kemudian di sel A8 masukkan fungsi =sum(A2:A7) kemudian enter, fungsi 

sum()  berfungsi menjumlahkan semua data yang ada dalam  range yang 
dimaksud, yaitu dari A2 hingga A7. 
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3.    Kemudian gandakan fungsi yang di A8 ke B8 dan C9 
 

b.    Fungsi Average () 
 

1.    Dari data sebelumnya kita akan belajar membuat fungsi average (). 
Ketikkan di D2, =average (A2:C2) kemudian enter. 

 

 
 

2.    Hasil di sel D2 adalah 73, yang merupakan nilai rata‐rata dari A2 hingga C2. 
Selanjutnya gandakan di sel  D3, =average(A3:C3) 

 

 
 

3.    Kemudian gandakan di sel D4, D5, D6,dan D7. Dari latihan ini kita tahu 
fungsi Average () adalah mecari rata‐rata dari sejumlah nilai. 

 

C. Fungsi Max() 
 

1.    Fungsi Max () ini berfungsi untuk mencari nilai terbesar dari sejumlah data. 
Untuk mengetahuinya, ketikkan di lembar kerja anda. 
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2.    Kemudian  kita  akan  mencari  nilai  terbesar  di  sel  B7,  ketikkan  rumus 
=max(B2:B6), kemudian hasilnya adalah 150000. 

 

D. Fungsi Min() 
 

1.    Menggunakan data yang ada sebelumnya, gantikan isi sel dengan: “Harga 
Terkecil”. 

 
2.    Lalu ketikkan rumus =min(B2:B6). Rumus ini berfungsi untuk mencari nilai 

terkecil dari sejumlah data. 
 

 
 

3.    Hasillnya adalah 55000. 
 

E. Fungsi Count() 
 

1.    Kemudian kita akan belajar tentang fungsi count() yang menghitung 
banyaknya bilangan dalam sejumlah data. Gantikan sel A7 dengan 
“Banyaknya Barang”. 

 

2.    Kemudian di sel B7 masukkan rumus =count(B2:B6) 
 

 
 

3.    Kemudian hasilnya adalah 5. 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 6 Kerjakan Tugas Modul 6 ini, simpan dengan nama Tugas Modul 6.xlsx 
 

1.    Isikan nilai rata‐rata setiap siswa 
2.   Lalu  isikan  di  bagian  bawah  dengan  rata‐rata,  jumlah  total  nilai  terbesar,

nilai  terendah  dan  jumlah  siswa  gunakan  fungsi  sum(),average(),  max(),
min(), count(). 

 
 
 

Laporan Nilai Ujian Kelas 8 
 

No Nama Matematika B. Indonesia B. Inggris Rata‐Rata 

1 Arya 85 95 80  

2 Bona 75 85 80  

3 Charlie 80 85 75  

4 Endang 90 85 85  

5 Fira 95 90 85  

6 Indah 65 80 80  

7 Koko 75 85 80  

8 Lina 60 75 70  

9 Manfred 50 80 90  

10 Nino 90 75 75  

11 Okta 80 80 80  

12 Surya 95 70 90  

13 Tita 80 80 85  

14 Untung 80 80 85  

15 Wira 70 75 80  

Rata‐rata     

Jumlah Total     

Nilai Tertinggi     

Nilai Terendah     

Jumlah Siswa     
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Modul 7. Menggunakan Fungsi Lanjutan 
 

Materi Langkah Detailnya 
 

Menggunakan Operator 
Dan Eksprsi Logika. 

1. Buatlah lembar kerja yang baru (Ctrl+N). 
 

2. Klik pada cell C5, kemudian ketikkan =5>2, kemudian tekan tombol Enter, 
perhatikan hasilnya. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Klik pada cell C6, kemudian ketikkan =5<2, kemudian tekan tombol Enter, 

perhatikan hasilnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Klik pada cell C7, kemudian ketikkan =5>=5, kemudian tekan tombol Enter, 

perhatikan hasilnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Klik pada cell C8, kemudian ketikkan =5<=5, kemudian tekan tombol Enter, 

perhatikan hasilnya. 
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6.  Klik pada cell C9, kemudian ketikkan =5<>5, kemudian tekan tombol Enter, 
perhatikan hasilnya. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Materi Langkah Detailnya 
 

Menggunakan Fungsi 
Logika If. 

1. Ketikkan dokumen ini di lembar kerja anda. 
 

 
 
2. Klik pada cell G3, kemudian ketikkan =IF(H3>65;"Lulus";"Gagal"), kemudian 

tekan tombol Enter. Perhatikan hasilnya. 
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Keterangan rumus: 
 

=IF(H3>65;"Lulus";"Gagal") artinya jika nilai sel H3 lebih besar dari 65 maka 
lulus, jika nilainya lebih kecil artinya Gagal. 

 
3. Selanjutnya kopikan rumus tesebut ke range G2:G7, jika telah selesai maka 

hasilnya adalah sebagai berikut. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Simpanlah kembali dokumen kerja anda. 
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Tugas Langkah Detailnya

Tugas Modul 7 Kerjakan Tugas Modul 7 ini sesuai perintah kerjanya, kemudian simpan dengan
nama “Tugas Modul 7”. 

 
 
 

1.   Ketikkan tugas ini di lembar kerja anda, kemudian isikan kolom Keterangan dan Reward 
dengan aturan sebagai berikut: 
a.   Keterangan  :  Jika  Realisasi  Penjualan  LEBIH  BESAR  dari  Target  Penjualan,  maka 

nilainya “Berhasil”, jika tidak maka nilainya “Gagal”. 
b.   Reward   :   Jika   nilai   dari   keterangan   adalah   “Berhasil”   maka   nilainya   “Diberikan 

Intensif”,   dan   jika   nilainya   “Gagal”   maka   nilai   sel   Reward   adalah   “Tidak   Dapat 
Intensif”. 
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Modul 8. Menyisipkan Objek 
 

Materi Langkah Detailnya 
 

Menyisipkan gambar 
dari Clip Art 

1.    Buka lembar kerja anda, kemudian klik menu Insert  > Clip Art. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Setelah itu muncul  Taskpanel Insert Clip Art. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Geser scrollbar untuk menampilkan gambar yang dikehendaki, kemudian 
klik salah satu gambar. 

 

4.    Gambar akan disisipkan pada posisi titik sisip. 
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5.    Kemudian simpan hasil kerja anda. 
 

Materi Langkah Detailnya 
 

Menyisipkan gambar 
dari File 

1.    Selanjutnya kita akan memasukkan gambar, klik menu Insert > Picture > 
From File. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Akan muncul kotak dialog Insert Picture. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.    Klik salah satu gambar. 
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4.    Gambar akan disisipkan pada posisi titik sisip. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.    Kemudian simpan hasil kerja anda. 
 

Materi Langkah Detailnya 
 

Menyisipkan gambar 
Autoshapes 

1.    Materi ini kita akan membahas untuk memasukkan Shapes di lembar kerja 
anda, klik menu Insert > Shapes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Akan muncul Taskpane Autoshapes. 
 

3.    Geser scroll bar untuk menampilkan gambar yang dikehendaki. 
 

4.    Klik salah satu gambar. 
 



Copyright © 2008 Webmedia Training Center 

 

Page | 65 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.    Gambar akan disisipkan pada posisi titik sisip. 
 

 
 
 
 
 
 
 
 
 
 
 
 

6.    Simpan hasil kerja anda. 
 

Materi Langkah Detailnya 
 

Menyisipkan Wordart 1.    Kemudian kita akan belajar untuk membuat WordArt yang merupakan 
fasilitas pelengkap mempercantik dokumen teks anda. Klik menu Insert‐ 
WordArt. 

 

 
 

2.    Akan muncul Taskpanel WordArt. 
 

3.    Klik salah satu gambar. 
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4.    Gambar akan disisipkan pada posisi titik sisip. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.    Simpan hasil kerja anda. 
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Tugas Langkah Detailnya

Tugas Modul 8 Kerjakan tugas modul 8 ini sesuai dengan perintah yang ada di setiap tugasnya

 
 
 
 

1.    Buatlah sebuah lembar kerja untuk bahan praktikum anda di sekolah. Kemudian simpan dengan 
nama Tugas Modul 8 ‐1.xls 
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2.   Buatlah  sebuah  catatan  pertandingan  Bola  Basket  seperti  di  bawah  ini.  Simpan 
dengan nama Tugas Modul 8‐2.xlsx 
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Modul 9. Bekerja dengan Diagram dan Grafik 
 

Materi Langkah Detailnya 
 

Membuat diagram 
dan grafik 

Ketikkan dokumen ini pada lembar kerja anda: 
 
 
 
 
 
 
 
 
 
Kemudian kita akan membuat grafik berdasarkan dengan data di atas, caranya: 
 
1.    Blok data yang inginditampilkan dalam grafik (contohnya seperti data 3 siswa 

yang ada di range A1:E4. 
 

2.    Klik tombol Insert > klik tombol column di bagian chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.    Klik Design untuk memilih layout tabelnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.    Setelah  anda  pilih  grafik  yang  anda  inginkan  langsung  muncul  di  lembar  kerja 

anda. 
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Memilih Jenis 
Grafik 

Dari dokumen kerja anda sebelumnya. 
 

 
 
 
 
 
 
 
 
 
1.    Klik tombol insert > klik grafik yang ingin kalian pilih, misalnya seperti di bawah 

ini. 
 

• Bentuk line/ garis Klik line. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Klik design untuk memilih layoutnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Coba lakukan eksperimen dengan memilih beberapa jenis grafik yang ada. 
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Memberi judul 
grafik 

1.    Dari data sebelumnya klik Layout > Pilih Chart Title > pilih dan klik Above Chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.    Maka akan muncul table Chart Title. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.    Ganti  chart  title  dengan  judul  yang  diinginkan.  Misalnya  sekarang  kita  akan 

membuat table “DAFTAR NILAI”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Kemudian simpan hasil kerja anda. 
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Mengatur tampilan 
grafik 

1.    Pada grafik selalu ada sumbu X, Y dan Z. tapi di sini, kita memakai sumbu X dan 
Y saja. Untuk sumbu dikenal sebagai axis. 

 

2.    Keterangan pada Axis dapat dimunculkan atau dihilangkan. 
 

• Untuk memunculkan Axis caranya sebagai berikut. 
Untuk sumbu X Klik Layout > Axis Title > Primary Horizontal > Title Axis. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Untuk Sumbu Y  Klik Layout > Axis Title >Vertical Axis > Vertical Title. 
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• Untuk menghilangkan Axis juga bisa, coba perhatikan contoh di bawah ini. 
 

Untuk menghilangkan sumbu X  Klik Layout > Axis Title > Primary Horizontal 
> None. 

 
 
 
 
 
 
 
 
 
 
 

 
 

Untuk Sumbu Y  Klik Layout > Axis Title >Vertical Axis > None. 
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3.    Simpan hasil kerja anda. 
 

Materi Langkah Detailnya 
 

Mengatur tampilan 
garis grid 

Kalau anda ingin melakukan perubahan, maka garis grid (gridlines) yang ditampilkan 
(sebagai background grafik) adalah garis Y mayor. Seperti gambar di bawah ini. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Kemudian kita akan melakukan perubahan dengan cara di bawah ini. 
 

1.    Klik Layout > Gridlines  > Horizontal Gridlines > Major Gridles. 
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2.    Klik Layout > Gridlines  > Horizontal Gridlines > Minor Gridles. 
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3.    Klik Layout > Gridlines  > Horizontal Gridlines > Major & Minor Gridles. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.    Klik Layout > Gridlines  > Horizontal Gridlines > None. 
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5.    Kemudian simpan hasil kerja anda. 
 

Materi Langkah Detailnya 
 

Mengatur posisi 
legend 

Legend   adalah   keterangan   tentang   garis‐garis   yang   ada   di   grafik.   Satu   grafik 
biasanya   lebih   dari   satu   garis.   Masing‐masing   garis   tersebut   mewakili   atau 
menerangkan sesuatu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Legend  atau  keterangn  gambar  bisa  diatur  posisinya.  Kita  bisa  meletakkan  legend 
disamping  kanan,  kiri,  atas,  bawah,  tengah  atau  sudut.  Selain  itu  legend  bisa 
disembunyikan. 

 



Copyright © 2008 Webmedia Training Center 

 

Page | 78 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Caranya sebagai berikut. 
 

Klik Layout > Legend  > pilih sesuai keperluan. 
 

Untuk sekarang kita mencoba Klik Layout > Legend >Show legend at bottom. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Coba lakukan untuk jenis lainnya. 
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Materi Langkah Detailnya 
 

Data Label Selanjutnya kita akan belajar menampilkan data label pada grafik, caranya: 
 

Klik Layout > Data Labels  > pilih sesuai keperluan anda. 
 

Untuk sekarang kita mencoba Klik Layout > Data Labels  > Center. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Coba lakukan untuk jenis lainnya. 
 

Materi Langkah Detailnya 
 

Menyertakan Data 
Table di grafik 

Data label bisa membuat grafik  menjadi penuh sehingga menyulitkan membaca 
grafik. Cara agar lebih bisa dibaca adalah meletakkannya di bawah, caranya: 
 

Klik Layout > Data Table  > pilih sesuai keperluan. 
 

Kemudian klik Layout > Data Table > Show Data Table With Legend Keys. 
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Untuk jenis lainnya silahkan dicoba. 
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Tugas Petunjuk Pengerjaan Tugas

Tugas Modul 9 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas
Modul 9” . 

 
 
 

Buatlah diagramnya dalam bentuk Column. 
 

 

DAFTAR NILAI SISWA 
No Nama Kelas Bahasa.Indonesia B.Inggris Matematika 
1 Titin Mayasari 7A 86 65 85 
2 Eri Yanto 7B 75 74 93 
3 Muhammad Taufan 7C 93 59 89 
4 Supra Yogi 7D 85 71 63 
5 Novi Jayanti 7E 95 70 85 

 

 
 

Yang hasilnya seperti di bawah ini. 
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Modul 10. Mengurutkan Data 
 

Materi Langkah Detailnya 
 

Mengurutkan data Coba ketikkan contoh di bawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Data di atas masih belum teratur, sekarang coba urutkan mulai dari yang terkecil 
ke yang terbesar, caranya: 

 

1.    Blok angka‐angka tersebut (sel A1:A10). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Pilih Editing > Sort & Filter > Sort Smallest to Largest . 
 
 
 
 
 
 
 
 

3.    Sekarang data sudah diurutkan mulai dari terkecil hingga terbesar. 

Kemudian lakukan kebalikannya, dengan mengurutkan dari yang terbesar ke 
yang terkecil: 

 

1.    Blok angka‐angka tersebut (sel A1:A10). 
 
 
 

2.    Klik pilih Editing > Sort & Filter > Sort Largest to Smallest. 
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3.    Sekarang data sudah anda urutkan dari yang terbesar hingga terkecil. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selanjutnya silahkan ketik dokumen berikut ke lembar kerja anda. 
 

 
 
 
 

1.    Blok sel C2 sampai dengan sel C6 (Kolom Nilai). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.    Klik  Sort Largest to Smallest hingga muncul jendela baru. 
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3.    Maka hasilnya seperti di bawah ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Kalau   anda   ingin   mengurutkan   data   berdasarkan   nama,   maka   yang   harus 
dilakukan sama dengan mengurutkan nilai. Hanya saja, yang anda ubah bloknya 
adalah kolom nama. 

 

 
 
 

Tugas Petunjuk Pengerjaan Tugas 
 

Tugas Modul 10 Ketikkanlah dokumen berikut dan setelah selesai simpan dengan nama “Tugas 
Modul 10” . 

 
 
 
 
 
 
 
 
 
 
 
 

Urutkanlah data diatas berdasarkan : 
 

1.    Daftar nilai B.Indonesia 
 

2.    Daftar nilai B.Inggris 
 

3.    Daftar Matematika dan 
 

4.    Daftar nama 
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Modul 11. Pengaturan Halaman 
 

Materi Langkah Detailnya 
 

Pengaturan halaman Buka file Tugas Modul 10, kemudian ikuti langkah pengerjaan di bawah ini: 
 

Klik Page Layout > Margins > Costum Margins. 
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1.    Mengatur posisi dan ukuran halaman. 
 

• Pastikan  tab  yang  aktif  adalah  tab  Page.  Kemudian  atur  posisi  halaman, 
pastikan ke bagian Orientation. 

 
• Kalau   orientation   yang   dipilih   Portrait,   maka   posisi   halaman   akan 

memanjang (vertical). Kalau Landscape yang dipilih, maka posisi halaman 
akan melebar (horizontal). Untuk latihan kali ini pilihlah Portrait. 

 

 
 

• Bagian  Paper  size.  Paper  size  adalah  ukuran  kertas  yang  akan  dipakai. 
Ubahlah paper size menjadi A4. 

 

 
 

Setelah  langkah  di  atas,  berarti  halaman  bagian  pertama  telah  berhasil 
diatur. 

 

2.    Mengatur batas tepi (margin) halaman. 
 

• Pindahkan tab aktif ke tab Margins. 
 

• Perhatikan batas‐batas yang ada. 
   Top adalah batas atas halaman. 
   Botton adalah batas bawah halaman. 
   Left adalah batas kiri halaman. 
   Right adalah batas kanan halaman. 
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3.    Mengatur header dan footer halaman. 
 

Header  dan  footer  adalah  catatan  yang  diletakkan  pada  bagian  atas  dan 
bawah  halaman.  Header  ada  dibagian  atas,  sedang  footer  di  bagian  bawah. 
Biasanya  header  dan  footer  dipakai  untuk  memberi  keterangan  tambahan 
dari dokumen yang sedang kita buat. 

 

Cara untuk mengatur header dan footer seperti di bawah ini. 
 

• Pindahkan tab aktif ke tab Header/Footer. 
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• Pertama, kita akan membuat header. Kita bisa memilih daftar header yang 
sudah disediakan. 

 
Kalau anda ingin membuat header sendiri, klik saja tombol Custom Header, 
maka anda bisa menuliskan header sesuai keinginan. Ikuti langkah‐langkah 
lengkapnya. 

 
   Untuk latihan ini kita pilih Custom Header sehingga muncul jendela 

baru. 
 

 
 

   Isilah bagian Left section dengan namamu, misalnya “Novi dj”. Sedang 
Right section dengan “Soal‐Soal Latihan”. 

 

   Kalau sudah selesai klik OK. 
 

 
 

   Untuk footer, pilih salah satu model footer yang telah disediakan. 
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   Nah, sekarang coba amati perbedaan pada tampilan lembar kerja 
excelmu. 

 

 



Copyright © 2008 Webmedia Training Center 

 

Page | 90 

Modul 12. Pencetakan Dokumen Kerja 
 

Materi Langkah Detailnya 
 

Pencetakan Berkas 1.    Pertama,  tentukan  berkas  yang  akan  dicetak  dengan  cara  membukanya 
dari folder yang ada. Misalkan kita akan mencetak file Latihan. 

 

2.    Klik menu Office Button > Open. 
 

3.    Lalu carilah file yang akan anda cetak, setelah itu klik Open. 
 

4.    Setelah file terbuka klik  Klik menu Office Button > Print. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.    Setelah itu akan muncul sebuah jendel a baru “Print”. 
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6.    Jika anda akan mengatur Page nya anda klik  Properties > Page Size > 
Orientation > Ok. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.    Jika anda ingin menentukan sendiri halaman yang akan diprint. Anda klik 
ke page dan isi halaman berapa yang akan anda print. 

 

8.    Jika anda ingin memprint lebih dari satu halaman maka klik tombol Copies 
> ketik berapa banyak lembar yang akan diprint. 

 

9.    Setelah selesai klik tombol OK.
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